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1 Introduction 

Grant applications for the Europe for Citizens Programme must be made using the eForm. 

Applications submitted on paper by post, fax or e-mail will NOT be accepted for further evaluation. 

The purpose of this document is to provide guidance on the technical aspects of completing and 

submitting the eForm. It does not replace the document Europe for Citizens Programme Guide (latest 

version, valid from January 2013) which must be read and consulted by applicants for all guidance on 

the content of the application form.  

The Programme Guide has been updated. Please ensure you are consulting the latest version (valid 

from January 2013) which can be found on the following webpage: 

http://eacea.ec.europa.eu/citizenship/programme/programme_guide_en.php 

Please note that the terms 'eForm', 'form', 'application form' and 'online application form' are used 

interchangeably throughout this guide. 

You are strongly advised not to leave the preparation and submission of your application form until 

the last days before the deadline for applications 

 

Please read all of this User Guide before beginning your application 

2 Technical Requirements & Considerations 

The online grant application form is an interactive PDF form that requires Adobe Reader software.  

The form is an 'online' form because it is retrieved by you from the EACEA website and must be 

submitted whilst you are connected to the internet. However, in between the retrieval of the form and 

its submission, the form works as an offline document i.e. it is stored on your local computer and is 

filled out by you on your local computer.  

Adobe Reader 

The minimum version i.e. lowest version of Adobe Reader that you must have installed on your 

computer is version 8.1.5. You may also use a higher version than this e.g. 9.0, 9.1, X, 10.1.1, XI etc. 

If you have a lower version than 8.1.5, you will not be able to complete and submit the eForm. 

Follow the link below to be directed to Adobe's website to download the software free of charge or to 

upgrade your existing copy of the software. If you do not have administrator rights on your computer 

this activity may require the intervention of your IT department. You will need to specify your 

operating system before the download can commence. 

http://get.adobe.com/reader/otherversions/ 

If you are using Adobe Acrobat (Standard) or Adobe Acrobat Professional, the version must likewise 

be 8.1.5 or higher. 

The screenshots in this User Guide are based on version 8.1.6 of Adobe Reader. 

You can check the system requirements for Adobe Reader – i.e. the minimum required specification of 

your computer – through the following link: 

http://www.adobe.com/uk/products/reader/systemreqs/ 

http://eacea.ec.europa.eu/citizenship/programme/programme_guide_en.php
http://get.adobe.com/reader/otherversions/
http://www.adobe.com/uk/products/reader/systemreqs/
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Security settings in most versions of Adobe Reader and Adobe Acrobat 

If you are using a version of Adobe Reader or Adobe Acrobat that incorporates Enhanced Security, it 

is very likely that the enhanced security settings will block the submission of your eForm. The 

involved versions of Adobe Reader and Adobe Acrobat are: 

 8.2 or any higher version 8 than this (including any sub-versions e.g. 8.2.1, 8.2.2 etc); 

 9.3 or any higher version 9 than this (including any sub-versions e.g. 9.3.1, 9.4.2 etc); 

 any version X (including any sub-versions e.g. 10.0.1); 

 any version or sub-version higher than version X e.g. version XI. 

The disabling of the Enhanced Security is performed from the following Adobe Reader menu path: 

 Edit > Preferences > Security (Enhanced) 

Uncheck the box Enable Enhanced Security and click OK. Once the submission has been performed 

you can re-enable the Enhanced Security. For more detailed instructions (including screenshots),  

please refer to the relevant 'Known Issue' on the following webpage: 

http://eacea.ec.europa.eu/eforms/index_en.php#issues 

Here you will also find instructions on how to leave Enhanced Security generally enabled but identify 

your eForm as a trusted item so that its submission is not blocked. 

Internet Connection & Browser software 

You will require an internet connection and standard browser software to retrieve and submit the 

online application form. 

Test eForm 

A test eForm is available on the EACEA eForm home page: 

http://eacea.ec.europa.eu/eforms/index_en.php 

The form contains a small number of questions and functions. It has been designed to help applicants 

understand how the main fields in the eForm work and also to ensure that their own software and 

internet connection allow an application form to be submitted. It is NOT mandatory to use this form; it 

is provided as a help tool for applicants who are using electronic submission for the first time. 

Advice for Macintosh Users 

The eForm can only be opened and completed using Adobe Reader or one of the Adobe Acrobat 

products. It is not possible to open and work with the eForm using the Mac Preview viewer. 

Please therefore ensure that if your default viewer is set as Mac Preview, you nonetheless open the 

eForm with one of the Adobe products mentioned above. This advice applies to both the download of 

the form – if you try to open it before downloading – and to the opening of the form for its general 

completion and submission. For more detailed advice, please visit the ‘Known Issues’ section of the 

EACEA eForm home page: 

 http://eacea.ec.europa.eu/eforms/index_en.php#issues 

http://eacea.ec.europa.eu/eforms/index_en.php#issues
http://eacea.ec.europa.eu/eforms/index_en.php
http://eacea.ec.europa.eu/eforms/index_en.php#issues
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3 The Online Application Process – Overview 

(i) You download the eForm from the agency website, saving it to your own computer or local 

network drive. Do not try to fill in the form directly on the website. The form can only be 

filled in once you have saved it to your local computing environment. 

(ii) You complete the eForm on your own computer (as an ‘offline’ document). You do not need 

to be connected to the internet for this and no connection to the EACEA website or any 

Commission server is required. Completion of the form includes the attachment of the 

annexes.  

(iii) You validate the form (on your own computer) to ensure that it is ready for submission. 

(iv) You connect to the internet and press the submit button to submit your form. You do not need 

to be connected to the EACEA website or to any particular webpage – this connection to the 

Agency server happens automatically. (The submission process includes a mandatory save 

both before and after the submission. These save operations are instigated by the form itself. 

This is explained in detail in section 8.)  

(v) If the submission is successful, a submission number will be automatically generated and 

added to your form. 

(vi) You can print the form for your own records. 

(vii) An email acknowledging receipt of your form is automatically sent to the email address that 

you entered for the contact person of the Applicant Organisation (Part A.2).  

4 Working with the eForm 

4.1 Download the eForm from EACEA 

A link to a read-only copy of the form can be found on the EACEA eForm home page:  

http://eacea.ec.europa.eu/eforms/index_en.php 

Save the form to your local computer or network drive, respecting the following filename convention: 

Action and/or Measure reference_applicant ISO country code_applicant organisation name_AppForm.pdf 

e.g. Measure 1.2_BE_MyCompany_AppForm.pdf 

You can now open, save, close, print etc the file in the same way you would any other document you 

had saved or created on your own computer. 

4.2 Adobe Reader – a brief introduction to some key features of the pdf form 

 

 

 

Activate the 

Highlight Fields 

facility 

VERY 

USEFUL! 

Attach facility  

DO NOT USE! 

The eForm has its 

own attach facility 

Activate  

Page Thumbnails 

(see below) 

Adobe Help for 

common features Navigation panel, 

on the left-hand 

side of the screen 

http://eacea.ec.europa.eu/eforms/index_en.php
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Toolbar 

From the Tools menu you can customise your toolbar e.g. you can add the Save button if it is not 

already displayed. There are also various display and navigation options that you can add. 

 

 

 

Explained here are some of the commonly used display and navigation options: 

 

 

 

 

 

 

Toolbar 

Customise 

toolbar 

selection 

menu 

(partial view) 

Zoom In 

(reduce 

image size)  

Zoom Out 

(enlarge 

image size)  

Fit form to 

width of 

screen and 

scroll across 

page 

boundaries 

Turn on ‘Page 

View’ – 

 1 whole page 

displayed  at a 

time  

Move 

back 1 

page  

Move 

forward 1 

page  



  [Version 1] 

 Page 7 of 24  

Page Thumbnails 

If you activate the Page Thumbnails option, a new panel is opened up on the left-hand side of the 

screen. It contains miniature previews (‘thumbnails’) of each page: 

    

Zoom in / Zoom out 

To rapidly zoom in or out, press CTRL on your keyboard and move the scroll wheel on your mouse: 

  Scroll up  to zoom out, increasing the size of the image 

  Scroll down   to zoom in, decreasing the size of the image 

4.3 eForm completion 

The eForm is an interactive PDF form that contains form fields that are either selected from a 

restricted list or filled in using free text: 

Click inside a text field to enter data. 

Click to select options from e.g. dropdown lists, checkboxes, pop-up calendars and radio 

buttons. 

Press Tab to move forward one field or Shift+Tab to move backward one field. 

Point and click with the mouse to select a specific field. 

Please note that when you use the tab facility, the tab doesn’t just ‘land’ on modifiable form fields – it 

also lands on the various buttons and unmodifiable form fields that appear in the form. In order to 

reach the next field that you wish to complete, simply continue tabbing until the cursor point arrives in 

the desired field. 

 Use the 

thumbnails to 

jump to different 

areas of the form.  

 

 A frame outlined 

in red indicates 

where you are in 

the document. 

 

 Right click on the 

panel to access 

options to enlarge 

or reduce the 

thumbnails.  

Red 

frame 

indicating 

your 

location   
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4.4 Mandatory, optional and calculated fields 

Field Type Characteristics Examples 

Mandatory  

Field label is 

accompanied by an 

asterisk *       

Optional Field label has no asterisk 

    

Calculated 

automatically 

Field contains diagonal 

grey lines.      

How to highlight mandatory fields 

Click on the purple button  in the navigation panel and this will activate the Document message 

bar which incorporates the Highlight Fields feature. 

 

Mandatory fields –  red border and a light blue background 

Optional fields –  light blue background (and a black border when you hover the cursor over them). 

 

 

        

Please note: if any mandatory field remains incomplete the eForm will not validate successfully and it 

will not be possible to submit your form. Where a numerical field is mandatory but you have no value 

to enter e.g. in table C.3, please make sure you enter a zero to indicate your null value. 

Once you have activated the highlighting you can click the purple  button again to remove the 

Document message bar (and maximise the display of your form). 

Click on the Highlight Fields button and all 

mandatory and optional fields will gain 

highlighting that makes them easier to identify 

(and easier to differentiate from one another). 

Unhighlighted fields Highlighted fields 
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4.5 Saving your form 

To save your form, click on the Save button on the toolbar or select Save from the File menu or press 

CTRL and S. 

 

Please ensure that you save your form on a regular basis. If you encounter a problem in your local 

computing environment and your form or your computer crashes, the Adobe Reader auto-recovery 

function will only restore your form to the point of the most recent save. 

4.6 Entering Dates and Numbers 

Please respect the following rules when entering dates and numbers on the form: 

 Rule Example 

Numbers Commas act as decimal commas 
50,75 for fifty euros and 

seventy-five cents 

Dates 
All date fields are in the format 

dd/mm/yyyy 
01/10/2012 for 1st October 2012 

Telephone numbers No rules -  this is a free text field - 

4.7 Using the Add and Delete buttons (eForm tables) 

Some fields or groups / blocks of fields are required to be completed more than once allowing you to 

build up a 'table' of information e.g. the list of organisations involved in your project or the details of 

the Twinnings. Whenever you need to insert a new 'blank' field or add rows to a table, you will do this 

by using the Add buttons. 

These buttons are coloured green. Click on them to add the desired new field or table row. 

 

 

 

 

 

Once you have added a field or row, the delete facility – an orange-coloured button containing an 'x' – 

appears so that you can delete the field, block of fields or table row concerned (and its contents!). 

Please note: some tables are optional but contain fields that are mandatory once a row has been 

added. An example of this can be seen in the screenshot immediately above (Part B.3, table 2). 

 

Click here to 

add a new 

row 
Click here to 

delete a row 
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4.8 Formatting 

If you enter formatted content into the form e.g. through copy-and-paste from other document sources, 

the eForm will strip off the formatting and plain text only will be pasted into the form.  

Please do not copy bullet points into your form. The formatting of some bullets can trigger the 

requirement to download add-ons to your Adobe Reader software (so that it can handle those bullets). 

4.9 Character Limits 

The free text fields in the eForm have character limits that restrict the amount of text you can enter. 

These limits include both characters AND spaces. If you try to enter more characters than the limit 

allows the form will simply restrict the text to the predefined limit. Many word processing packages 

have a 'count' tool that may help you respect the limits.  

For the major fields, the limits are displayed in the headings and sub-headings of the eForm. For other 

fields, please consult the following table: 

Part Field Character Limit 

A 

Project Title 300 

Project Acronym (see section 5.1) 7 

Full name of the organisation 62 

Name in latin characters 62 

Acronym 62 

Department (if applicable) 40 

Street 57 

Street Number 5 

Postcode 12 

Town 60 

Internet address 60 

Telephone 1 and Telephone 2 60 

Fax 60 

Family name 62 

First name 62 

E-mail 100 

Role in the organisation 32 

B.3 

Programme or initiative 25 

Reference number 40 

Beneficiary Organisation 62 

Title of the Project  300 

Programme concerned 60 

C.2 

Venue of the activities, Town (Action 1 Measure 1.1 only) 60 

Venue(s) of the activities (All Actions & Measures other 

than Action 1 Measure 1.1) 
2,000 

E.2 Pertinence of the project and methods proposed 3,500 

E.4 If one or more of the three types of communication tools… 1500 for each occurrence 

F 

Type of Activity 200 

Venue of the activity 60 

Content 500 

Expected results 500 
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5 Guidance for specific Parts of the form 

5.1 Cover Page 

Important! 

Please ensure that you complete all the fields of the Cover Page (page 1) before going on to 

complete the rest of the form! 

This is because the selections that you make, dictate how the rest of the form appears e.g. a   

different budget table appears in Part C.5 for each Measure that can be selected. 

Information concerning the deadlines for submission 

for Action 1 Measures 1.1 and 1.2 

Please be aware of the following constraints: 

 Applications may only be submitted for the Round that is current i.e. for the next 

scheduled deadline – the online system blocks the submission of applications that are for 

a deadline that is not the next scheduled deadline. 

 Once a deadline has passed, there is a gap in time before the online submission system is 

re-opened for the next scheduled deadline. Here are the details of when the online 

submission system is opened for each deadline: 

o Round 1 – Submission was opened when the eForm was published; 

o Round 2 – Submission open from 01/03/2013; 

o Round 3 – Submission open from 01/07/2013. 

 If you attempt the submission having selected a deadline that is not the next scheduled 

deadline OR when the online submission system is closed, the submission of your form 

will be blocked and it will not take place. Nevertheless, it will still be possible for you to 

submit that same form once the submission has been opened for the Round / deadline you 

are interested in. Be aware, however, that the submission process will have locked your 

form so you will no longer be able to modify its content or change the attachments. 

 It is not possible to submit an application for a deadline that has already passed. The 

online system blocks such submission attempts. 

 If you have attempted the submission for a deadline that has passed, it will not be possible 

to correct the deadline value (and retry the submission) because the form will be locked. 

You would therefore be obliged to start your application again with a new form. 

If you are in doubt about the schedule of deadlines, please check the Citizenship funding 

opportunities webpage: 

  http://eacea.ec.europa.eu/citizenship/funding/2013/index_en.php 

http://eacea.ec.europa.eu/citizenship/funding/2013/index_en.php
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The Project acronym field is limited to 7 characters. If you require an acronym that is longer than this, 

please include the full acronym of your project at the start of your Project title and then enter the first 

7 characters of the acronym in the Project acronym field. 

5.2 Parts A and B – Organisations 

For each organisation in your consortium a part A and a part B must be completed. Please note the 

following: 

 The ‘Role in the application’ field is not a field that you can modify. Instead, its value is 

dependent upon the Partner number value. The roles and partner numbers are set as follows:  

o P1 is automatically set to have the role of Applicant. 

   
 

o For subsequent partners – P2, P3 etc – the role is automatically set to Partner. 

  

 The field ‘Internet address’ in Part A.1 relates to the organisation’s website address. 

 The field A.3 – details of the Legal Representative – is only required to be completed for the 

Applicant Organisation. Consequently, it only appears in the form for the Applicant 

Organisation (P1). For all subsequent organisations, the field A.3 is omitted and only fields 

A.1 and A.2 are presented for completion. 

 The Registered address you enter in Part A.1 is automatically copied to Parts A.2 and A.3. 

Check the relevant checkbox in order to write different address details in Parts A.2 or A.3. 

 The Add organisation(s) button has an accompanying field that allows you to add multiple 

organisation rows at the same time. These rows are in addition to any that you have already 

added. The new rows are introduced into the form above the Add organisation(s) button not 

below it. It is recommended that you add your additional organisations in one go. 

 Because parts A and B taken together represent the details of a single organisation, the form 

‘numbering’ does not follow a ‘pure’ A, B, C, D, E, F but evolves as follows:  

A, B, A, B, A, B, A, B, A, B……….C, D, E, F 
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 At the end of Parts A and B, a summary table – the List of partner organisations – is built up 

for you automatically. As you enter your partners in Parts A and B, the List updates to reflect 

the content you have added.  

 

Please note: this List is protected and cannot be used to add or delete organisations. This can 

only be done through the green Add and orange Delete buttons described earlier.  

Tip  

When selecting a country value, instead of deploying the dropdown list, enter the initial letter of the  

country into the field. This will take you to the first country in the list that begins with that letter. Press 

the same letter again to bring up the next country. For example, entering the letter ‘c’ three times in 

succession would bring up: 

Croatia 

then Cyprus 

then  Czech Republic.  

The up and down arrow keys on the keyboard can also be used to navigate the list – without deploying 

the dropdown list – once an initial selection has been made. 
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5.3 Part C – Description of the Project 

C.1 Timetable of the project 

Check the rules for your Action and Measure and then enter valid dates. 

C.3 Participants 

For every organisation that you enter in Parts A and B a corresponding row for you to complete will 

automatically appear in the table in Part C.3. 

All fields are mandatory. If you have no value for a given field, enter a zero. If any field is left blank it 

will fail validation.  

C.5 Budget 

The format and content of the budget table that appears is dependent upon the Measure that you 

selected on the Cover Page. 

If a budgetary rule has been broken, you will see red font in your table. Please ensure that all 

budgetary rules are respected and that you have no red figures in the budget table. 

If you are applying for one of the following action / measure / budget type combinations there is a 

budget annex that must be completed and attached to your eForm: 

 Action 1 Measure 2.1; 

 Action 1 Measure 2.2; 

 Action 2 Measure 3 with a budget type of “Production and realisation project”; 

 Action 4 with a budget type of “Production and realisation project”. 

 

In all other scenarios, the grant is calculated automatically within the eForm on the basis of the 

information you supply in Part C.5 and there is no budget annex to be attached. 

5.4 Part E – Project implementation / Award criteria 

Specific aims of the action 

The options that appear are dependent upon the Measure that you selected on the Cover Page. 

E.4 – Types of Communication tools 

If you selected Action 1, Measure 1.2 on the Cover Page, the types of communication tools – 

Publications, DVD/CD-ROM and Website – become mandatory fields. For all other actions / 

measures these fields remain optional. 

5.5 Part F – Work programme 

The format and content of the table that appears is dependent upon the Measure that you selected on 

the Cover Page. 

You may add and use several work programmes to describe the same event. So, if you run out of 

characters for your description simply add another work programme. This is done by clicking on the 

Add a work programme button: 

 

For example, if your event runs over a number of days you can add a separate work programme for 

each day. Or if your event consists of several activities you can add a separate work programme for 

each activity. 



  [Version 1] 

 Page 15 of 24  

6 Attaching Documents to your eForm 

All eForm applications must have attached within the eForm the following mandatory annex:  

 Declaration of Honour (DH). 

Further annexes may be required depending on your selection of action, measure and, where relevant, 

budget type. These annexes are: 

 Budget; 

 Financial Identification Form (FIF); 

 Legal Entity Form (LEF). 

Based on your selections, the form automatically detects which annex buttons are required and adds 

them to your form. For your convenience, the following table summarises which annexes are required 

for each combination of action, measure and, where relevant, budget type. 

Combination of Action / Measure / budget type DH Budget FIF LEF 

Action 1 / Measure 1.1      

Action 1 / Measure 1.2     

Action 1 / Measure 2.1     

Action 1 / Measure 2.2     

Action 2 / Measure 3 / budget type Production and 

realisation project 
    

Action 2 / Measure 3 / budget type Event project     

Action 4 / budget type Production and realisation 

project 
    

Action 4 / budget type Event project     

Legend: 
 = annex is mandatory 

 = annex is not applicable 

Please respect the following filenames and formats for your attachments: 

Annex Required Filename Required Format 

Declaration of Honour DH .pdf 

Budget Budget .xls or .xlsx 

Financial Identification Form FIF .pdf 

Legal Entity Form LEF .pdf 

Attachment size limitation 

There is a limit to the total (combined) size of your attachments. This is 5MB. If you receive a 

message advising you that the total size of documents exceeds the maximum allowed, please reduce 

the size of the image-based documents e.g. by reducing their resolution. 

To carry out the attach function, click on the relevant Attach a document button and a window will 

pop up enabling you to browse, locate and select the file you wish to attach: 
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Once a file has been successfully attached, the filename is displayed and the Attach a document  

button is replaced by a Delete this document button and a View this document button: 

 
  

Click on the ‘Open’ button 

to attach the selected file 

to your application. 
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Viewing attached documents 

You may encounter the following information message when trying to view non-PDF documents that 

you have attached: 

   

If so, you can change your settings – to allow such documents to be opened – via the following Adobe 

Reader menu path: 

 Edit > Preferences > Trust Manager 

Check the box Allow opening of non-PDF file attachments with external applications and then click 

OK to confirm the setting change: 
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7 Validation of your eForm 

The Validate Form button appears at the foot of every page of the form.  

 

It is recommended that you do not validate your form until you have finished completing it as 

validation slightly alters the look of the form. 

When you are ready, click on the button and various checks will be automatically performed to 

ascertain whether your form is ready for submission. For example, the validation will verify that all 

mandatory fields have been completed and all the mandatory attachments are present. 

If there are any errors present, the total number of them will be listed on the last page of your form. If 

there are any budget or attachment errors these will be itemised separately in the same list:  

 

The errors themselves will be highlighted in pink. In the example that follows the mandatory field 

Short description of the project has not been completed: 

 

When you validate, an additional button – the Go to next error button – appears next to the Validate 

form button.  
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Use this button to jump from error to error in your form. Please note the following: 

 When you fix the errors that are highlighted, the Errors List is not dynamically updated. It is 

only updated i.e. refreshed when you perform another validation. 

 The Go to next error function works best when you fix errors one by one, following the top-

to-bottom sequence used by the Go to next error button. If you fix errors out of sequence e.g. 

fix an error further down the form, the Go to next error function will still follow the original 

sequence of errors reported by the validation.  

 If you have fixed errors out of sequence, you are recommended to perform a fresh validation 

so that the errors you have fixed are removed from the sequence (and you would then start 

again from the error nearest the top of the form). 

 If you prefer, you can simply do a visual search for the pink errors in your form. If you do 

this, it is recommended that you first turn off the highlighting for mandatory fields (see 

Section 4.4). You may find the thumbnail view a useful aid to quickly detecting the pink 

highlighted fields (see Section 4.2). 

Whichever method you use, fix the errors that are present and validate your form again. If all errors 

have been resolved you will see the following pop-up message: 

 

Until your form validates successfully the Submit button is disabled and it will not be possible to 

submit your form. The Submit button turns from grey to green when validation has been carried out 

successfully. 
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8 Submission of your eForm 

On the final page of the form is the Submit this form button. Once your form has been successfully 

validated the button is enabled (as confirmed by its green colour). Before proceeding with the 

submission, please ensure you have consulted and, where necessary, followed the advice on Adobe 

security settings found in section 2 of this user guide. 

Please note: the submission process includes the locking of the data and attachments in your form. 

You may therefore wish to take a backup copy of your form before you begin the submission process. 

When you are ready, click on the Submit this form button to launch the submission. 

 

The following message will appear: 

 

If for any reason you do not want to continue, you may click No and carry out the submission at a later 

time. The submission process will end. Once you click Yes your form will be locked and it will no 

longer be possible to modify its content, including the attachment(s). 

Should you encounter any error messages during the submission of your form, please refer in the first 

place to the ‘Known Issues’ section of the eForm home page: 

http://eacea.ec.europa.eu/eforms/index_en.php#issues 

8.1 The mandatory save BEFORE submission 

If you click Yes, the next step of the submission process is a mandatory save. The following message 

appears: 

 

When you click OK, the form triggers a Save As operation. You will see the classic Save As window as 

appears in the screenshot below.  

(Please note: the screenshot below is simply an example of the Save As window. The window that you 

see, will reflect the filename and directory name that you have been using.)  

http://eacea.ec.europa.eu/eforms/index_en.php#issues
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You must now perform the Save As operation by clicking on the Save button. 

Very Important! 

You must NOT change the filename of your eForm. 

You must keep the same filename that the file had when you began the submission operation!  

Click Yes when you are asked if you want to replace the existing file: 

       

8.2 Submission 

Depending upon your security settings, the following pop-up window may now appear: 

          

Example screenshot 
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If the window appears, click on the Allow button in order to proceed with the submission. 

When the submission is complete you will see a pop-up message similar to the one that follows: 

       

Click ‘OK’. 

8.3 The mandatory save AFTER submission 

When you click OK, the form triggers another Save As operation. This is so that you cannot 

mistakenly close the form without saving (and so lose the submission number).  

Once again you will see the classic Save As window appear: 

      

You must now perform the Save As by clicking on the Save button. 

Very Important! 

You must NOT change the filename of your eForm. 

You must keep the same filename that the file had when you began the submission operation!  

 

Example screenshot 
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Click Yes when you are asked if you want to replace the existing file: 

       

When you click ‘Yes’, the submission number is automatically added to the ‘Submission number’ 

box:  

 

It is also inserted into the footer of your form. The form has also been saved and this save included the 

submission number. 

Your submitted form is now ‘locked’. That is to say, it has been converted to a read-only document: 

changes cannot be made to it and it cannot be re-submitted. As part of the submission process, an 

email message acknowledging receipt of your eForm is automatically sent to the email address you 

entered for the contact person of the Applicant Organisation (Part A.2).  

As advised by the earlier pop-up message, you may now print the form for your own records.  

*** Please Note! It is NO longer required to send to the Agency by post a printed copy of the 

eForm and its attachments! *** 

For details of the documents and annexes that must be submitted by post, please follow the relevant 

Action / Measure link from the funding opportunities webpage: 

http://eacea.ec.europa.eu/citizenship/funding/2012/index_en.php 

*** The submission number must be clearly written on all documents submitted by post! *** 

9 Printing your eForm  

The eForm can be printed using Adobe Reader’s standard menu-driven print function. The Print 

button is found on the tool bar, or the Print menu can be selected from the File menu.  

 

10 How to obtain technical assistance – EACEA Technical HelpDesk 

If this User Guide does not provide answers to all of the technical questions or problems you 

encounter in completing the application form, a telephone and email HelpDesk service is available to 

assist you further: 

EACEA Technical HelpDesk: +32 229 90705 

eacea-helpdesk@ec.europa.eu 

Monday to Thursday 08:30 to 17:30 

Fridays 08:30 to 17:00 

Excluding Belgian public holidays 

All times are Brussels time 

http://eacea.ec.europa.eu/citizenship/funding/2012/index_en.php
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Should you experience what you believe to be a significant technical issue with the eForm it will be 

worth checking the Europe for Citizens programme website since, in the event of a general technical 

problem, an update bulletin would be posted.  

You may also visit the Agency’s dedicated eForm webpage which contains the latest versions of all 

published forms along with a Test eForm and other items of information: 

 http://eacea.ec.europa.eu/eforms/index_en.php 

Non-technical assistance 

If you require assistance with a query or problem that is not technical in nature, please do not contact 

the EACEA Technical Helpdesk. This Helpdesk team are only authorised and trained to help 

applicants who are encountering technical problems. 

Please refer instead to the funding opportunities webpage of the programme/action that you are 

applying for. On this webpage you will find details of how to obtain non-technical assistance e.g. 

assistance with questions on: 

 the content of the eForm; 

 the application procedure including instructions for the documents to be sent by post; 

 the rules of the programme / Call that you are applying for. 

Generally speaking, the funding opportunities webpage will include the mailbox address of the 

programme team that is responsible for the programme/action that you are applying for. The page will 

also contain documentation that may already provide an answer to your non-technical question e.g. a 

Programme Guide or Instructions for Applicants document or a link to an in-country Helpdesk which 

can help you. If you cannot find the answer to your question, please contact the mailbox of the 

programme team cited on the funding opportunities webpage. 

The following table provides some examples of technical and non-technical questions. 

Technical Questions 

(handled by the EACEA Technical Helpdesk) 

Non-technical Questions 

(handled by the programme team) 

I can’t download the form. 
What is required to be entered for the field Other EU 

Grants? 

A dropdown list isn’t working. Why isn’t country A in the dropdown list? 

I can’t attach my budget form (or other 

annex/attachment). 
I need help with completing my budget form. 

How does the synchronisation of fields work? Why is this field mandatory? 

I can’t delete a table row that I have entered. 

Our project has more than one coordinator. 

What should I do? 

What is the minimum / maximum number of partners that 

is allowed? 

My form freezes/crashes. 
What documents are required to be sent by post and 

where do I send them? 

My form is working slowly. I need more characters for my answer! 

My form won’t validate. What do you mean by the term ‘acronym’? 

My form won’t submit. 
Where are the templates for the attachments and 

additional documents? 

I think there is a bug in the form. 
What should I enter in the form for my project start and 

end dates? 

 

http://eacea.ec.europa.eu/eforms/index_en.php

